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Exploring ArcCatalog and ArcMap

IN THIS CHAPTER

Introducing ArcCatalog
Viewing data in ArcCatalog
Connecting to data
Introducing ArcMap

Working with maps

Exploring a map

Adding a layer to a map
Adding features from a database
Changing layer symbolization
Adding labels

Laying out a map

Saving a map

Printing a map

What’s next?

Maps are the most commonly used tools for understanding spatial informa-
tion. Whether you do analysis or editing, produce wall maps or illustrate
reports, design GIS databases or manage them—when you work with GIS
you work with maps. ArcMap allows you to work with all of your geo-
graphic data in maps, regardless of the format or location of the underlying
data. With ArcMap, you can assemble a map quickly from predefined
layers, or you can add data from coverages, shapefiles, geodatabases. grids,
TINs, images, and tables of coordinates or addresses.

Two other GIS applications—ArcCatalog and ArcToolbox—are designed to
work with ArcMap. In ArcCatalog, you can browse, organize, and docu-
ment your data and easily drag and drop it onto an existing map in ArcMap.
Using the tools in ArcToolbox, you can project and convert data. If you are
working in ArcInfo, ArcToolbox also has tools for sophisticated
geoprocessing. It has never been easier to use the power of GIS.

In this chapter, you will create a map for a planning meeting of the
Greenvalley City Council. You will use ArcCatalog to find the data and
produce the map in ArcMap.
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Introducing ArcCatalog

ArcCatalog is the tool for browsing, organizing,
distributing, and documenting an organization’s GIS data
holdings.

In this exercise you work for the (fictitious) City of
Greenvalley. The City Council is debating a proposal to
build additional water mains downtown. As part of the
process, the Council is reviewing water use in the
downtown area.

You have been asked to make a map that shows the water
mains in downtown Greenvalley and the relative water use
at each parcel downtown.

To make the map easy to read, you will add the data to a
general-purpose map of the town.

Start ArcCatalog
1. Click the Start button on the taskbar.
2. Point to Programs to display the Programs menu.

. Point to ArcGIS.
. Click ArcCatalog.

98]
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% Accessories 4
% Startup r
’ E Command Prampt

@ “Windows NT Explorer

@ Administrative Tools [Common] ¥ |
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@ Startup » @ ArcObjects Developer Help
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ArcCatalog starts, and you see two panels in the
ArcCatalog window.

¥ ArcCatalog = e
J File | Edit View Go Tools Help
|t s®m|m @ x| min e Qe v
|leaaveo|® g |
| Logaon~ [Faalon =] |
JStylesheet. E | = = S |
- 2| Contents | Preview | Metadstal
: Marnne | Tupe
i@ CY
g o @ Folder Connection
@D Folder Cannection
4 | |
W

The Catalog tree on the left side of the ArcCatalog window
is for browsing and organizing your GIS data. The contents
of the current branch are displayed on the right side of the
Catalog window.
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Viewing data in ArcCatalog

When you need more information about a branch of the
Catalog tree, you can use the Contents, Preview, and
Metadata tabs to view your data in many different ways.

In this example, the ArcInfo coverage “cl” contains street
centerlines. It is located on a computer’s E:\ drive in a
folder called City.

=-{ C:
=g DA
- BN
g--@ E:ACity
L EEP

i L&) annotation

§ @j' climits -]

If you select a data source in the tree, you can view it in
several ways, depending on the tab that you choose. Each
tab has a toolbar associated with it that allows you to
modify how you see your data.

These are Contents views:

Contents I Previewl Metadatal

atinotation arc bic:

Contents I Previewl Metadatal

[ arne | Type |
(2] annatation Annotation Feature Class
arc Arc Feature Class
tic Tic Feature Class
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These are Preview views:

Contents  Freview | Metadata

Record: EILII
Previews: ITabIe

Kl

N

ARCTYPE FID DATE Pfﬂ
701 413818 193301 21
;gg ii Contents  Preview | b etadata I
0 -
7 N _I

Preview: IGeograph_l,l

ARV
j

These are Metadata views:

Contentsl Preview Metadata |

cl
Eontentsl Preview Metadata |
Metad -
cl
o Ider Coverage
» Spa
* m Description Spatial
+ List
o DIufet
B Details for cl.aat
Tvpe of object: Feature Class
Murmber of records: 4530
4] Attributes
FID_1
Shape
FMODE# LI
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Connecting to your data

When you start ArcCatalog for the first time, the Catalog
tree has a branch for each local hard drive. Branches for
Coordinate Systems, Database Connections, Geocoding
Services, Internet Servers, and Search Results can be added
by clicking the Tools menu and clicking Options, then
checking the check boxes next to the branches you want to
add to the catalog. You can view the contents of a branch
by double-clicking it or by clicking the plus sign beside it.

You can also create new branches in the Catalog tree to
make it easier to navigate to your data. These branches are
called connections.

Before continuing, you will need to know where the
tutorial data has been installed on your system.
Make a connection to the tutorial data

Now you will add a connection to the folder that contains
the tutorial data. This new branch in the Catalog tree will
remain until you delete it.

1. Click the Connect to Folder button.

'

e |om|=e X

0O L
=p pms |EE HE

When you click the button, a window opens that lets you
navigate to a folder on your computer or to a folder on
another computer on your network.

20

2. Navigate to the ArcGIS\ArcTutor\Getting_Started\
Greenvalley folder on the drive where the tutorial data
is installed. Click OK.

Connect to Folder K E

Chooze the folder bo which you want to connect;

IC: Mol S A T utotGetting_Started G reervalley

- ArcGls =]
{:l ancexed]

=0 ArcTutar J
{:I ADAnalyst

D BuildingaGeodatabaze

{:I Catalog

-] Editor

{:I Geocoding
-] GeoStats
E|{:| Getting_Started
=R Y Grecnyvaley =l

]

Cancel |

The new connection shows up as a branch in the
Catalog tree.

x|
[ Catalag
B TN
@ CoivAreGShAreTutort\Getting Started W Greerwalley
=g Do
- E:

- Dratabaze Connections
- Geocoding Services
[-E&] Intemet Servers

- Search Resuls
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Explore the Greenvalley folder connection

You can now look at the tutorial data that you have added.

1. Click the ArcGIS\ArcTutor\Greenvalley folder to view
its contents on the right side of the ArcCatalog window.

2. Click the plus sign to expand the connection in the
Catalog tree. This branch of the tree contains a folder,
map documents, and a layer.

,:l ArcCatalog - Arcinfo - C:VArcGISVArcTutor\G etting_Started\Greenvalley

J File Edit Wiew Go Took Help |
|ejoazex|.xFxaladv|aecreo|®s |
J Location: IC:\AICGIS\ArcTulor\Gettingﬁlarted\Gleenva\ley j
|| Contents | Freview | Metadats |

Bl Catalog

a o Mame | Tupe

ERFYC: sy || Data Folder

B Data & Downtown water Map D ocument

H 3 GreenvalleyDR &) Greenvalley Map D ocument

) Downtown water Water Use Layer

Greerwalley

L g Water Use

@t

g EN

Database Connections

-- Geocoding Services

=8 Internet Servers

-\ Search Fiesulis

I | JLa | | | 2

4

The Greenvalley folder has a special icon to show that it
contains GIS data. By default, ArcCatalog recognizes many
different file types as GIS data including shapefiles,
coverages, raster images, TINs, geodatabases, projection
files, and so on. If the list of recognized file types does not
include a file type that you use in GIS analysis, you can
customize ArcCatalog to recognize additional file types—
for example, text files—as GIS data.
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The Greenvalley map document is a general-purpose map
of the City.

The Water Use layer shows a set of parcels in Greenvalley
with a color scheme that indicates relative water use at
each parcel.

Maps and layers

Maps and layers are important ways of organizing and
displaying data in ArcGIS.

Maps, such as everyday paper maps, can contain many
kinds of data. The data on a map is organized into layers,
which are drawn on the map in a particular order. Each map
contains a page layout where graphic elements, such as
legends, North arrows, scale bars, text, and other graphics,
are arranged. The layout shows the map page as it will be
printed.

Layers define how a set of geographic features will be
drawn when they are added to a map. They also act as
shortcuts to the place where the data is actually stored—not
necessarily the same place as where the layer file is stored.
In this case, both the map and the layer refer to data that is
stored in the Data folder.

If you store your geographic data in a central database, you
can create maps and layers that refer to the database. This
makes it easy to share maps and layers within an
organization and eliminates the need to make duplicate
copies of your data.
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View the thumbnail sketch of the Greenvalley map

The right-hand panel of ArcCatalog displays datasets in
many different ways. You can click an object in the left
panel to view it in the right panel. One of the views that
can be useful when you want to select a particular map is
the thumbnail view.

1. Click the Thumbnails button on the Standard toolbar.

You can see the thumbnail sketch of the map.

Conterts | F'reviewl Metadatal

Mame:  Greenvalley. mxd
Type: Map Document

areenvalley. mad
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Open the Greenvalley map

You will use the Greenvalley map to provide context for
the information that the City Council wants.

1. Double-click Greenvalley in the Catalog tree.

|

Ib |)¢-

Bl Catalog
- Ch
EI@ ChareGIS AT utar G etting_Starl
=0 Data

. B GreenvalleyDB

@ Drovuntawn ' ater
Greenvalley
i WwWater Use
= D

& E

-1 Natahaze I'fnnnﬁr.rinrﬁ

1

sl

Double-clicking a map in the Catalog tree opens the map in
ArcMap.

Sometimes you may want to start ArcMap without opening
an existing map. You can start ArcMap by clicking the
Launch ArcMap button in ArcCatalog.

QG N

Launch ArcMap button

You can also start ArcMap as you would any other program
on your system, whether the Catalog tree is open or not.
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Introducing ArcMap

ArcMap is the tool for creating, viewing, querying, editing,
composing, and publishing maps.

Most maps present several types of information about an
area at once. This map of Greenvalley contains three layers
that show public buildings, streets, and parks.

You can see the layers in this map listed in the table of
contents. Each layer has a check box that lets you turn it on
or off.

]— ArcMap Table of Contents
(5 N - |
=2 buildings_paint .
Adniristative Point features
A CivHal
Other
Post Office
@ Public Library
{ Public Slags
Fublic Safaty
2 Fire Station
[3] Greenvalley Hospital
i Police Headouarters
- Police Station 3
Schools
£ FirElementary
£ Gresnvalley High
£ Laurel Middle School
£ Dk Middle Schacl
b Pine Elementary
T sl ac Line features
Type
— Major Road
— Primary Street
— Secondary Strest ||
= parks_polygon
= =| Area features
S 10
Dispey [Source ]

Within a layer, symbols are used to draw the features. In
this case, buildings are represented by points, streets by
lines, and parks by areas. Each layer contains two kinds of
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information. The spatial information describes the location
and shape of the geographic features. The attribute
information tells you about other characteristics of the
features.

In the park layer, all the features are drawn with a single
green fill symbol. This single symbol lets you identify
areas that are parks, but it does not tell you anything about
the differences between the parks.

In the street layer, the features are drawn with different line
symbols according to the type of street that the lines
represent. This symbol scheme lets you differentiate streets
from other types of features and tells you something about
the differences between the features as well.

In the buildings layer, the features are drawn with different
point symbols. The shapes and colors of the symbols allow
you to differentiate the institutions that they represent. All
of the schools are grouped together and drawn with a
particular symbol, so you can easily differentiate schools
from the hospital or from City Hall. Each school symbol is
drawn with a different color, which lets you differentiate
Pine Elementary from Greenvalley High.
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Working with maps
ArcMap offers many ways to interact with maps.

Exploring

Maps let you see and interpret the spatial relationships
among features. You could use the map you have just
opened to find City Hall, to identify parks near schools, or
to get the names of the streets around the library.

Analyzing

You can create new information and find hidden patterns
by adding layers to a map. For example, if you added a
layer of demographic information to the Greenvalley map,
you might use the resulting map to define school districts
or find potential customers. If you added layers of geology
and surface slope, you might use the map to identify arcas
at risk for landslides.

Presenting results

ArcMap makes it easy to lay out your maps for printing,
embedding in other documents, or electronic publishing.
You can quickly make great maps of your data. When you
save a map, all of your layout work, symbols, text, and
graphics are preserved.

ArcMap includes a vast array of tools for creating and

using maps. In the rest of this chapter, you will use some of

these tools.
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Customizing

Maps are tools for getting a job done. You can create maps
that have exactly the tools you need to help you complete
your job quickly. You can easily customize the ArcMap
interface by adding tools to existing toolbars (or removing
them) or by creating custom toolbars. You can save these
changes to the interface with a particular map or for every
map that you open.

You can also use the Visual Basic® for Applications (VBA)
programming language included in ArcMap to create new
tools and interfaces. For example, you can create a VBA
tool to make a table of the addresses of houses in a selected
area. Once the tool is created, you can associate it with a
custom toolbar and save it with a map for anyone to use.

Programming

You can build completely new interfaces for interacting
with your maps and create new, specialized classes of
features. ArcGIS is built using Microsoft’s Component
Object Model (COM); all of the COM components are
available to developers using a COM-compliant
programming language. For more information about
customizing ArcMap and ArcCatalog, refer to Exploring
ArcObjects.
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Exploring a map

You can explore a map in several ways. The Tools toolbar
contains frequently used tools that let you navigate around
the map, find features, and get information about them.

Zoom in and get information

If you want to see an area of the map in greater detail, you
can zoom in to the map.

1. Click the Zoom In button.

2. Drag a box around one of the parks to zoom in to it.

?

J@@xz@@«»@ﬁingf

When you drag a box on the map after clicking the Zoom
In button, the map zooms to the new area. You can click the
Back button to jump back to the previous map extent.

3. Click the Identify Features button and click the park.

When you click a feature with the Identify Features tool,
the Identify Results window appears. You can inspect the
attributes of the feature from this window.

If the tool finds several features where you clicked, it lists
cach feature on the left side of the window. You can click
the features in this list to view their attributes on the right
side of the window.

4. Close the Identify Results window.

ExpLoRrING ARcCATALOG AND ARCMAP

Ideniify Results =] ]—o

Layers: |<Top—mosl layers .j

[ parks_palygon |Location: (434055, 903175 376E529.046218)

=% Fisid [alus

FIDr 27

Shape Palygon

PARKS-D 27

Shape_Lenath 2129 80129848085
Shape_frea 128445 852785263
Name lri

Maintenance City

Zoom to the map’s full extent

If you have zoomed in to the map and want to see all of it,
you can quickly zoom out to the map’s full extent.

1. Click the Full Extent button.

|® Q x x @D Ek 07

Now you can see the full extent of the map. The map scale
is around 1:95,000 (depending on your screen setup and the
size of the ArcMap window), which you can see on the
Standard toolbar. (If the map scale is not around 1:95,000
change it by clicking in the text box, replacing the text with
1:95:000, and pressing Enter.)

=g &2

- |[1:36.364

At this scale, the building symbols are not visible. The
Maximum Visible Scale property of this layer has been set
to 1:70,000. You will change some of the properties of a
layer later in this chapter.
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Find a feature

The Find button lets you search a map for features that
match your search criteria. The area you want to map is
around the Greenvalley City Hall, so you will find City
Hall and zoom to it.

1. Click the Find button.

[@@uuo@es Bk onz s

When you click the Find button, the Find dialog box

appears. You can search for features from a particular layer

or from all layers on the map.

2. Type “City Hall” in the Find text box. Click the In
layers dropdown arrow and click buildings_point. Click

In fields, then click the dropdown arrow, and click
NAME. Click Find.

! Find HE

Features IHoute Locationsl Addressesl find

Find  [City Hall Stop

o 1l

I lapers: Ibuildings_point Mew Search

[V Find features that are similar to or contain the search string

Search Al fields

& inficids [ESATS——————

£ Each layer's primary display field

Cancel
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City Hall appears in the list of features that the tool has
found.

Fiight-click a row ta show contest menw,

alue | Layer | Field
City Hall bwildings_paoink MARME
Flazh featurs

Zoom ta feature(s)

|dentify feature(z)

e objsct found, Set Bookmark )

Select featurels)

Unzelect feature(s)

3. Right-click City Hall and click Zoom to feature(s).

The map zooms to the City Hall. As the scale is now
greater than the 1:70,000 threshold, the building features
appear on the map, and you can see the blue triangle
symbol for City Hall.

4. Click Cancel to close the Find dialog box.

The map now shows some of the area that you need to map
for the City Council.

When you chose Zoom to feature(s), another option on the
list was Set Bookmark. A spatial bookmark preserves a
particular map extent so that you can zoom back to it
whenever you want.

Spatial bookmarks are saved with a map, so anyone who
opens a map can quickly zoom to a particular bookmarked
area.
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Zoom to a bookmarked area

Because you use this map to provide a context for other
information, you have created some spatial bookmarks for
the areas you frequently map. Downtown Greenvalley is
one of these areas.

1. Click View and point to Bookmarks.

2. Click Downtown Greenvalley.

Eiew|lnsert Selection Tool: Window Help

m D ata Wiew

[y Layout Yiew

Zoom Data

Zoom Layout

Ef Ceate...

I anage. ..

Bookmarks

Toolbars

Tahle OF Contents
Statuz Bar

Drawnbovan Greenwalley

=]
|7 Greenhillz

Overflov Labels. . Morth Greenwvalley

Identify Results...
E Scrollbars

B Filers

D-T- [Guides
Erid

['ata Frame Properties...

Now the map is zoomed to the downtown area. This map
extent and scale has been used for previous maps of
downtown Greenvalley. The map you are making will be
casy for the Council members to compare with the other
maps of the downtown area.
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ArcMap provides an excellent interface for interactively
exploring existing maps. You can use the tools you have
just used and others to answer questions about particular
features, find features, and view your maps at a variety of
scales.

You can change the information that is displayed on maps
by adding and removing layers and changing the way that
layers are displayed.

In the next part of this chapter, you will add data to your
map and change the properties of a layer.
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Adding a layer to a map

Now that you have opened a map of Greenvalley and set
the extent to downtown, it is time to make the map you
need. The City Council wants the map to include
downtown water use and the location and size of existing
water mains. You will start by adding the Water Use layer

to your map.

1. Position the ArcMap and ArcCatalog windows so that

you can see both of them.

2. Click the Water Use layer in ArcCatalog and drag it onto
the map. You can click and drag any layer from the
ArcCatalog tree onto an open map in ArcMap.

£

1 Catalog -
=-( T

E@ CvarcGIS e T uborG etting_Starl
=] Data

a GreenvalleyDB

@] Drownbown ' ater

| Greerwalley

ter Llze:

=@ D
@ E:*

1. Natahaze Cannectinps i
1| r 3

The layer shows parcels drawn with a graduated color
ramp. Just as the roads and buildings were drawn with
predetermined symbols when you opened the Greenvalley
map, this layer is drawn with a particular set of symbols.
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A layer serves as a shortcut to data. It also tells ArcMap
how the data should be drawn. You can store layers in a
place that is accessible to everyone in your organization
who needs a particular set of data; the data will be
displayed the same way for each of them.

As useful as layers are, sometimes they are not available.
Fortunately, you can add raw geographic data to a map just

as casily as you can add a layer.
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Adding features from a database

When you add features directly from a coverage, shapefile,
or database, they are all drawn with a single symbol.

Now you will add the water main features to your map.

1. Position the ArcMap and ArcCatalog windows so that
you can see both of them.

2. Click the plus sign next to the Data folder in the Catalog
tree to view the contents of the folder.

. Click the plus sign next to GreenvalleyDB.
GreenvalleyDB is a geodatabase that contains the
remainder of the data you will be using. The data in this
geodatabase is organized in five feature datasets:
Hydrology, Parks, Public Buildings, Public Utility, and
Transportation.

4. Click the plus sign next to Public Utility.

98]

5. Click watermains_arc and drag it onto your map.

I' "

& Catalog
G- T
E@ CohareGISharcTuborGetting_Starte
= Data

Elg GreervealleyDB

[]--@ Hudralogy

-4 Parks

-5 Public Buildings
= Public Utility =
S parcels_polygon
watermaing_arc

----- ] watermaing_nodes

[]--@ Tranzportation
_>I_I

@ Donwntown YW ater

1] |
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Watermains_arc is a feature class—a collection of features
represented with the same geometry (shape). In this case,
the features are polyline shapes that represent the pipes in
the water distribution system.
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}]ﬁ]]p.?l
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Geodatabases containing feature datasets and feature
classes are how ArcGIS applications manage geographic
information. In Chapter 3, you will learn more about these
and other GIS data types.
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Changing the way features are drawn

The Council wants to know the approximate sizes of the
water mains downtown, so you must assign some new
symbols to the features.

1. Right-click watermains_arc in the ArcMap table of
contents and click Properties.

Copy
¥ Remave

Open Attribute T able
Joing and Felates 3

<& Zoom To Layer

% ohools Wizible Scale Fange 3

Fir Elemantar Selection N

Label Features
Greenvalley k
EorrerLabels o snmotation, .

L

Corvvert Features to Graphics....

Dak Middle 5 Data >
Save fz Layer File...

&
&
L Laurel Midde
&
i

Fire Element

F'l|:||:|E=I'|.iE‘

= shreet_arc J
Type
== bl gjor Road
= Primary Street
— Secondam Shest T
1 ? 3

Display I Source I

The layer Properties dialog box appears. You can use this
dialog box to inspect and change a wide variety of layer
properties.
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The water mains feature class includes several attributes of
the water mains. As the Council wants to know the sizes of
the water mains, you will group the mains into five classes
based on their diameter attribute.

2. Click the Symbology tab on the Properties dialog box.

Properties H

Genera\l Sﬂumel Selectiﬂnl Display  Symbology IFie\ds I Definition Qualyl Lahelsl Jnins&ﬂelalesl
Shiow: -
Features |Dlaw all feat using the same spmbal. Import,
Single symbal
Categories
Quantities

Charts

Multiple Attributes

—Symbol

~Legend

Label appearing nest to the spmbal in table of contents: I

Ci E F .—Qm‘ Deescription.

:ij |'i Additional description appearing nest ta the symbol in your map's legend

oK I Cancel | Apply |

You can change the symbol scheme for the layer, as well as
its appearance in the table of contents, from this tab.
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3. Click Quantities. The panel changes to give you controls

5. Click the Value dropdown arrow and click DIAMETER.
for drawing with graduated colors.

ArcMap assigns the data to five classes using the

Natural Breaks classification (Jenks™ method).
Show:
Features Now the width of the line symbols indicates the diameter
E 1 . .
qi':.flfiﬂf: 4_9 of the water mains. You want the water mains to be blue, so
8 Grad you will change the base symbol.
Graduated symbols
s Proportional symbalz .
Charts Propeities BB
Multiple Attributes General | Source | Selsction | Displsy  Symbology | Fisids | Definition Query | Labels | Joins & Relates |
_Fh::lules |Dlaw ities using symbol size to show relative values. Import.
Categories - Fisld Classifc
l;guanlilies Yalue |DIAMETEH =l TIafiral Breaks [erks] e
O N e P
i Propottional symbols
Charts | ’ Synbol Sizefiom [05 | w4
Multiple i Templal
Spmbal | Range [ Label I [ ===l
-3 0-3 b_l 0
3000001 -6 3000001 -6
——— 5000001 -8 5000001 -8
5000001 - 12 5000001 - 12
e 12,000001 - 20 12000001 - 20
4. Click Graduated symbols. The panel changes to give A
. . L] I0W Class Dreaks using feature values
you controls for drawing with graduated symbols.
. ; 0K | Concel spply
Shiow:
Features
Categories -
Quantities 6. Click Template.

i Graduated colors

10

i Propartional symbals
Charts

Multiple Attributes
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When you click Template, the Symbol Selector dialog box
appears. Here you can choose predefined symbols, such as
the Highway line symbol, or you can design your own
symbols.

7. Click Color. The color selector dialog box appears. You
can select one of the predefined colors from this palette
or click More Colors to mix your own colors using one
of several popular color models.

Symbol Selector HE

Categary: IAII j — Previe

-
Highwway Highway Ramp Expressway j

Ewprezzway Ramp  Major Road

Arterial Street

Collector Street Residential Street Railroad

[r— J— Properties...

Fiiver Boundary,
M ational

Boundary, State

Save | Beset

|
Moare Symbals - |
|
|

;I 0k I Cancel
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8. Choose a dark shade of blue and click OK.

Mo Color |

uaooooooo
ouodEdOmm
EOOENO0ONEN

[

o

u

CIulmimisial § T i s )
EEEEEEEEEN
(T
B O
o
|
]

EEEEEEEN
oddoommEO
OdddEdOeEE N
mEmymysyey § § § |
EEEEEEEEN

More Colars...

EEEEENOOH
EEEOEEEEEO

Now all of the water mains will be drawn with dark blue
lines, with the line width representing the diameter of the
water main.

9. Click OK on the Properties dialog box to see your map
with the new line symbols.

As you have seen, ArcMap has a rich set of line symbol
selection and editing tools. These and other tools also work
with point and polygon symbols.

Once you have set the symbolization for a layer to your
satisfaction, you can preserve it for later use by saving the
map (later in this chapter) or by saving the layer as its own
layer file such as the Water Use layer you added (see Using
ArcMap for step-by-step instructions).
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Adding labels to a map

The map now shows some of the street centerlines and
water mains with similar symbols. To avoid confusing a
map reader, you will add street names on the map and
change the street centerline symbol.

1. Right-click street arc in the table of contents.
2. Click Label Features.

Copy
¥ Remave

Open Attribute T able

DIAMETER Joing and Felates 3
—0-3
— 200000001 - 6 <& Zoom To Layer
= [, 00000007 - 8 Wizible Scale Range 3
w0 00000007 - 12 )
Selection »

a2 0000007 - 20
N = P
Type

. b jor Fload
— Frimary Street =¥ Conwvert Features to Graphics.

EorrerLabels o snmotation, .

— Secondany Stre Dt
=] parceks_polygon »
|:| USE_CLASS Save fz Layer File...
n
/| Tl - | Properties. .

Dizplay I Source I

ArcMap adds the names of the streets to the map.
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Change the street centerline symbol

L.

98]

Properties

Right-click street_arc in the table of contents again and
click Properties.

Click the Symbology tab.

. Click Features, then click Single symbol.

Source | Selection I Dizplay Symbology | Fields | Definition uuerpl Labelsl Joins & He\atesl

Impart.

General |

Show

Features |Dlaw all features usirlg the same symbol.

i Spmbal

Quantities
Charts
Multiple Attributes

~ Legend

Label appearing next to the symbol in table of contents:

Description... |

Additional description sppearing next to the symbol in your map's legend

ak. I Cancel | Apply |

The street centerlines will now be drawn with a single
symbol. You will change the default line color to a light
gray, so the centerlines will be visible but unobtrusive.

4,

Click the Symbol button.
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The Symbol Selector appears.

Symbol Selector EHE
Categary: I All j ~ Preview
Highwway Highway Ramp Expressway
— Optianz
Lolor:
Expressway Ramp  Major Foad Arterial Strest “wdidth: 1.00 =
Collector Shieet  Residential Street Railroad

— Properties. . |

Riwver Boundary. Boundary, State (e St - |
Mational

Save | Reset |

= ok | Cancel |

=
: Pine Elementary ;I

= watermaing_an:
DISAMETER
—0-3
— 3000001 -6
- 5000007 - 8
w5 000007 - 12
-2 000007 - 20

-E

=] parcels_palygon
USE_CLASS

o
i hd
| IJJ

Display I Source I

5. Click Color. Click a light gray and Click OK.

O——mooooomEO
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[ Mo Color

I 5 N
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EEEECOONSEEEEN
AEEEEEEEEENEEN

a
a
|
|

|
L1HE
Bl
[ J |
L) |
L) |

| kore Colars...

6. Click OK on the Properties dialog box.

Now the centerlines will be drawn in a light gray, so they
will not be confused with the water mains.
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Working with the map layout

All of the data you need is now on the map and has
symbols. The map that you are making for the Council
meeting will be printed in color on an 8.5" x 11" sheet of
paper and distributed to each council member.

1. Click View and click Layout View.

Wiew |nzert Selection Toolz ‘wWindow Help

m Drata e
@ Lapout Wi

Zoom Data b
Zoom Lapout 2
Bookmark: 3

Now you can see the map on a virtual page. The layers of
data appear in a data frame on the page. Data frames are a
way of organizing the layers you want to see together on a
map.

Lo B =

Data frame

Page

=
i |
YT | »]
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There is always at least one data frame on a map. This one
is called Layers; you can see its name at the top of the
ArcMap table of contents.

O £F Layers
= buildings_paint
Adrminigtrative

Ak CityHal

Other

Pozt Office
Public Libran
Publiz Stage

Public Safety
Fire Station
Greervalley Hozpital

You can add additional data frames to a map to compare
two areas side by side or to show overviews or detailed
insets.

|+

You can see all of the data frames on your map in Layout
view. If you switch back to Data view, you will see the
layers that are in the active data frame. The active data
frame is shown in boldface type in the table of contents.

In Layout view you can change the shape and position of
the data frame on the page, add other map elements such as
scale bars and legends to the map, and change the page size
and orientation.

The Layout toolbar is added to the ArcMap interface when
you choose Layout View.
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You can use the tools on the Layout toolbar to change the
size and position of the virtual page on your screen or to
zoom in or out of the virtual page.

loyout A
@@ EE DR b

You can also use tools from the Tools toolbar in Layout
View to change the extent of the layers that are shown in
the data frame.

T |
QAL PED Ik O ML T

2. Right-click on the page and choose Page Setup.

|| 1 1 1 1 1 |a 1 II ;I
1 ﬁ Fage Setup. ..

] Lz |é|_|"§| Change Layout...
b % E# Copy Map To Clipbaard
‘D_- 'E B2 Paste Crl+4
] i Select All Elements
S

FRulerz »
: Guides »
1 Grid »
_ I argiris (2 [
| Options... LI
= 2w ELI | _v|
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3. Click Landscape under Map Size and under Printer
Setup to change the page orientation then click OK.

Page Setup H
- Map Size i Printer Setup
™ Same as Printer Marne:
Standard Page Sizes: I MOMMIbunpan j
IEuslom j PFrinter Page Size:
widh T [inches =] | || dLeter =
Page Orientation:
Height: 25 . P :
¢ € Potiat & Landscape
Page Diientation: Printer Engine:
= Paortrait % Landscape I\N’lndows Printer ﬂ
- Map Setup
Dutput Image Hualiy: [¥ Scale map elements proportionally
Fast Maormal Best to changes in page size
...........
._J— ¥ | Stiow prirter margins o Layout

0K I Cancel

Now the page is in landscape orientation.

|||I|I|I|I|I5|I|I|I|I||1!:IId
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6. Point to the selection handle at the lower-right corner of
the data frame. The cursor becomes a two-pointed resize
cursor. Click the corner and drag it up and to the left.

You will add a scale bar, North arrow, legend, and title to
the page to help the Council members use the map.

First, you will make some space on the page for these other
map elements by reducing the size of the data frame.

4. Click the Select Elements button.

Bk O 8 ] T

5. Click the data frame to select it. The data frame is now
outlined with a dashed line and has selection handles at

its corners and edges.

Add a scale bar

1. On the Insert menu click Scale Bar.

fimg] Title
A Temt

B Meatline...

7 Legend...

] Morth dmov...

ﬂ Scale Bar...

B Scale Test.

[s2] Picture...
Object...
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The Scalebar Selector dialog box appears. Add a North arrow

2. Click one of the scale bars and click OK. 1. On the Insert menu click North Arrow.
Scale Bar Selector [ 2] <]
Previ
o a0 100 200 hiles =
ata Frame
Scale Line 1 = ms  a 12 b .
0os0 W0 hles N
S S Text
Scale Line 2
g Meatlne. .
050 m W0 hles &
Soale Line 3 i Legend..
hiles
0 50 i 200 300 400
Stepped Scale Line == Scale Bar..
050 oo 200 300 400 [— Em Scale Text.
Altemating Scale Bar 1 E Ficture...
Properties... |
o ET i i Obiject...
" HMore Styles -
Altemating Scale Bar 2
100 Sawe... | Reset
[ Ihfles
e = Cancel The North Arrow Selector appears.

2. Click one of the North arrows and click OK.

3. Click the scale bar and drag it to the empty space below
the left side of the data frame. [ North Arrow Selector
[ Al ”e x_
[
ESAI Morth 1 ESRAI Moith 2
' j <
; j ‘
ESRI Marth 3 ESRI Morth 4
- | o
— Ll ESRI Morth & ESFRI Moith & &I
a' o | ~ ﬂ —I LI . More Styles <
w@g w%ﬂ Save | Beset
: : = Ok I Cancel |
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98]

. Click the North arrow and drag it to the empty space
below the data frame and to the right of the scale bar.

] 4]

R A

Al !: Egul_

a|m|eL|

Add a legend

1. On the Insert menu click Legend.

=F DataFrame
fmg) Title

A Text

Ey Meatline...
g Legend...

i#] Motk Amow.

== Secale Bar..

Em Scale Test..

[&] Ficture...

Object...
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The Legend Wizard appears.

Legend Wizard
— Choose which layers you want to include in pour legend
Map Layers: Legend Items
buldings. poml.............; _>| buildings_point
street_aic shrest_arc

parks_palygon o parks_polygon *

Kl

Set the number of columns in your legend: 1 ,;]

Preview |

< Back I Mext » I Cancel |

Changing Legend Wizard parameters alters the appearance
of the legend on your map. The Legend Wizard takes you
through five dialog boxes that allow you to change the
layers included in your legend, the appearance of the
legend title, the appearance of the legend frame, the size
and shape of the symbol patches used to represent line and
polygon features, and the spacing between legend items.

In this case, the default legend parameters are appropriate
for your map. However, legend parameters can be modified
at any time by right-clicking the legend in the layout view
and choosing Properties from the menu that appears.

2. Click Next several times to step through the wizard,
accepting the default legend parameters. Click Finish
when done.
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The legend appears on your map.

3. Click the legend and drag it to the empty space to the
right of the data frame.

[ N -l
EEs e
] BB J
7] \ %ED
S
2|0 =« | 2

You can click on the blue selection handles to resize the
legend so that it fits along the right side of the page.

Add a title

1. On the Insert menu click Title.

£F Data Frame
o<
A Tent
Meatline. ..
3 Legend..

] Morth Ao,

== Scale Bar..

Em Scale Text..
Picture...
Object...
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A partial title, “Greenvalley”, appears in the layout view.

El

[

5@@%@@

@ fﬂﬁﬁ

2|0 =«

[

Greenvalley is the name of the map document, but you will

need a more explanatory title on the map.
2.

Type “Downtown Greenvalley Water Mains and Water

Use™. Press Enter, then click and drag the title to the top
and center it on the page.

o B

El

[4

P Syl 4318 Kt o Wil Ui

IEEIIIHK s
m ) |

Lagert

2|0 =K
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Saving a map

You have made a lot of changes to this map. Because you
want to keep the new map that you have created and also
keep the old template map, you will use Save As to save

this map under a new name.

1. Click File and click Save As.

dit Wiew Inzert Selection Tool: Window Help

[ Mew.. Chl+M
= Open.. Ctrl+0
n Save Chil+5
\'I; Add Data...

¥ Add Data from Geography Metwark. .
ﬂ Page Setup...

[&, Print Preview. .

=] Erint..

Map Properties.

Import from Arciew project. ..

E=port Map...

E it

Alt+F4

ExpLoRrING ARcCATALOG AND ARCMAP

2. Navigate to the Greenvalley folder.

3. Type “Downtown Water”. Click Save.

Save As

7] x]

Save in: | =3 Greerrvalley

deld=

Data
Greerralley
File narme: |D0wntown W ater . Save I

Save as hype: I.QrcM ap Diocuments [7.mxd)

L] Cancel |

Now you are ready to print a copy of this map for the City

Council.
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Printing a map

You can easily print the maps you have composed in
ArcMap. The Layout view lets you arrange map elements,
such as data frames, scale bars, and North arrows, on the
page exactly as you want them to print.

You can print your maps using any printer on your
network, and you can choose to print using Windows,
PostScript®, or ArcPress™ (if installed) printer engines.

1. Click File and click Print.

Edit Wiew Inzett Selection Toaol: ‘wWindow Help

| Mew... Chrl+M

= Open... Chrl+0

& Save Chil+5
Save Az,

\‘|; Add Data...

¥ Add Data from Geography Metwork. ...

ﬂ Fage Setup..

[& Frint Presview. .

&

Map Properties. .

Irport from Archiew project..

Export Map...

Exit Alt+F4
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The Print dialog box appears. You can change the default

printer by clicking Setup.

rint

— Frinter
Mame: ShOkMINbunpan

Status: Feady

Type: HP Lazerlet 44/ b4y PaztS cript
Wherer  4B.1.7.84:Raw

Comment: M3 South

™ Prirt to file

—Map Larger than Printer Paper

) Tile: mam bo printer paper
1Al

) Fages from:|1— {5 |1_

= Beale mam bo fibpritter paper

= Proceed with mrinting, some clipEng
&y GEEUT

— Printer Engine

Windows Printer

Properties... |

— Copies

Humber of copies:

2. Click OK.

You are ready to take the map to the Council meeting.

Close ArcMap and ArcCatalog.

3. Click File and click Exit, or simply click the Close
button (x) in the upper-right corner of the ArcMap
window. Do the same for ArcCatalog.
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What's next?

While making your first map, you learned how to start and
use two GIS applications: ArcCatalog and ArcMap.

In the next chapter you will learn more about GIS data and
how to work with various data types. Working in the field
of GIS analysis inevitably means working with geographic
data in a variety of different formats. Understanding the
advantages and limitations of each format is an important
first step in any project and is essential to the project you
will begin in Chapter 4, ‘Planning a GIS project’.
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